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New in Media Composer v2020.4

The following are new for Media Composer v2020.4:

• Apple ProRes Support

• macOS Catalina Support

• Avid Universal Media Engine (UME)

• Avid S1 Control Surface

• Avid MediaFiles Folder Location

• Windows 7 Note

• Resolution Name Changes

• New Select Project Window

• Timeline Sequence Map

• Bulk Edit

• Blank Panel

• Effect Palette Update

• Select Muted Clips

• Avid Titler+ Changes

• Interface Settings Update

• Trim Settings Update

• New ACES Output Transforms

• Mask Margin Presets

• Improved Color Correction Control

• Strip Silence

• Mapping Buttons at the Bottom of the Timeline
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New in Media Composer v2020.4
Apple ProRes Support

Media Composer supports the creation of Apple ProRes media in OP-Atom, MXF OP1a, and MOV 
containers on both Mac and Windows. Media Composer support for ProRes does not require 
QuickTime. 

You can select Apple ProRes when exporting as MOV or MXF OP1a. 

n Apple ProRes RAW is not yet supported

n Export of Apple ProRes SD MOV is not supported.

You can also select Apple ProRes in your Media Creation Settings.
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New in Media Composer v2020.4
macOS Catalina Support

This release of the editing application supports macOS v10.15.4 (Catalina). macOS Catalina 
exclusively supports 64-bit applications. 32-bit applications no longer run. 

Compatibility when running macOS Catalina or higher

• No support for DMF (Dynamic Media Folders)

• No support for Nitris DX and Mojo DX.

• No support for the Avid Title Tool Application or Marquee.

• If you have a Media Composer client that needs to connect to Production Management, you
cannot upgrade the macOS on your Media Composer system to Catalina.

• The Media Composer |Enterprise Admin tool is not supported on Catalina in this release. The
Media Composer |Enterprise client will run on Catalina.

• Avid NEXIS version 19.12.x is the earliest supported version to be supported with Catalina -
with the following caveat:

- Thunderbolt 3 Ethernet adapters will not work with Avid NEXIS 19.12.x on Catalina.
Thunderbolt 2 is fine. If you have a client system that uses Thunderbolt 3 and you need to
connect to Nexis on Catalina, you will need a Thunderbolt 3 to Thunderbolt 2 adapter, and
then attach your Thunderbolt 2 Ethernet adapter to that.

QuickTime functionality when running on a macOS Catalina system

Note the following regarding QuickTime on a macOS system:
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New in Media Composer v2020.4
What you cannot do:

• MP4 export

• Link to MOV or MP4 files using the following codecs: DNxHD with Alpha, Meridien, MPEG 
50, DV, MPEG 4 (H.263), Apple None, Apple Intermediate, DVCPro, PNG*, or other formats 
that require a QuickTime Codec

• Link to 3GP, 3G2, AU, AVI*, BMP*, DV, GIF, M4V, MID, MP2, MP3, MPE

• WAV and AIFF import/export containing uncompressed PCM audio at 8 and 32-bit

• Link, import or export QuickTime Reference, Same as Source

• Link, import or export Variable Frame Rate (VFR) H.264 in MOV, MP4

* Note this is just PNG in a MOV container; PNG image files will still be supported

* AVI Import is still supported on Windows systems without QuickTime installed

* Linking for BMP is not supported without QuickTime, however Import of BMP is supported 
without QuickTime

Avid is implementing the Avid UME plug-in for linking, importing and exporting. See Avid 
Universal Media Engine (UME)

n You may see some files linked with the 'QuickTime Plugin' in the Source Browser even when 
QuickTime is not available (for example, with. Catalina) because the AMA QuickTime plug-in can 
handle some files on its own, without QuickTime.

Avid Universal Media Engine (UME)

Avid has been working on a solution to remove Media Composer dependency on Apple QuickTime 
libraries. Avid is implementing the Avid UME plug-in for linking, importing and exporting. Note that 
if you use v2020.4 on a system with QuickTime still installed, you may not experience any 
immediate changes to working with files that rely on QuickTime.

n NOTE: The Avid Generic plug-in will be replaced by Avid UME.

Linking and Importing: Avid UME will be used for linking to and importing the following in 
v2020.4: 

• MOV

• MP4 

• TIFF - Single image and Image Sequences

• PNG - Single image and Image Sequences

• JPEG - Single image and Image Sequences

• EXR - Single image (Image Sequences supported since 19.6)

• MP3

• AAC

Exporting: Avid UME is used for exporting in v2020.4: 

• MOV 

• EXR 
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New in Media Composer v2020.4
Improvements when using UME

• Better H.264 performance

• Support for H.264 with rasters greater than 4K

• Native OP1a (released in 2019.6 but related to UME)

• EXR (released in 2019.12 but related to UME)

• Framerate and Raster changes on “import”

• Support for QuickTime clips where audio and video are of different lengths (when audio extends 
video, we insert black, or when video extends audio, we insert silence, to ensure all tracks are the 
same length) 

• Image based sequences support for PNG, TIFF, JPEG, linking to single OpenEXR files

Not currently supported with UME

• Support for 3GP, 3G2, AVI*, AU, BMP**, DV, GIF, MID, MP2, MPE 

• Support for linking to MOV of MP4 with Meridien, MPEG 50, DV, MPEG 4 (H.263), Apple 
None, Apple Intermediate, DVCPro, PNG*** 

• LiveLink 

• DMF (Dynamic Media Folders)

• QuickTime Ref support 

• SAS (Same As Source) 

*AVI import is still supported on Windows systems without QuickTime 

**Linking for BMP is not supported without QuickTime, however Import of BMP is supported 
without QuickTime 

***Note this is just PNG in a MOV container; PNG images files will still be supported 

DNxHD Changes

DNxHD media is also affected by these changes. DNxHD was updated to support the ADHRv2 
standard, which requires changes to how DNxHD is written and interpreted in MOV files. This 
means that existing MOV files containing DNxHD with Alpha, as generated in earlier versions of 
Avid products and 3rd Party products, will be converted to MXF OP1a upon linking. It also means 
that DNxHD MOV files created using UME will require an updated QuickTime PE/LE codec 
package in order to be supported by previous versions of Media Composer and 3rd Party products. 
The long-term maintenance streams of Media Composer (2018.12.x, 2019.12.x) will be updated with 
these codecs. In addition, a separate installer will also be available for use in 3rd Party applications. 

IMPORTANT NOTES:

• Clips linked using Avid UME will not be supported in pre-v2020.4 versions of Media Composer.

• Avid Generic will be removed as an available linking option, but will still be installed to support 
reading files linked in previous versions of Media Composer. 

• For systems where QuickTime is installed, AMA QuickTime will remain as a linking option, as 
an autodetect fallback for files that aren’t supported by Avid UME, and for reading files linked 
via QuickTime in previous versions of Media Composer. 
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New in Media Composer v2020.4
• Files linked with QuickTime in previous versions of Media Composer will not be automatically 
promoted to UME in MC 2020.4. As a result, on systems where QuickTime is not installed, you 
need to manually update your sequences with newly linked clips.

• On systems where QuickTime is installed, legacy QuickTime export will remain in Media 
Composer v2020.4, to be retired in a later release.

• In Media Composer v2020.4, even with QuickTime installed, UME is the autodetect default, 
with AMA QuickTime being the fallback if the file is not supported by UME. You may manually 
override UME link to use AMA QuickTime, however. 

• For systems with QuickTime installed, you may still use AMA QuickTime for linking media. 

• If you’ve already linked via QuickTime in a previous version, the media will continue to be 
linked via QuickTime. You will not need to relink your media.

• If you intend to go back to a previous version of Media Composer or if you don’t know what 
version of Media Composer may be used with a project, you may want to use QuickTime AMA 
for linking.

• For files that aren’t currently supported by UME, Media Composer will automatically use 
QuickTime AMA for linking

• Clips linked using UME will not be supported in pre-20.4 versions of Media Composer. If you 
link to media on a system that does not have QuickTime installed and you intend to bring that 
project and/or media to a system with a prior version of Media Composer, we recommend that 
you first import the media before moving. Otherwise you will need to relink your media in the 
prior software version, and not all media may relink. 

• Linked files from previous versions of Media Composer will not be automatically promoted to 
using UME. As a result, on systems where QuickTime is not installed, you need to manually 
update the sequences with newly linked clips. 

• Export will default to using UME, however there will be an option to use QuickTime if it is 
installed. This may be desirable if you need to export a format that UME does not yet support, or 
if you are exporting DNxHD in a MOV container that will be used by an application that does 
not have the new Codecs PE / LE installed. 

• If you aren’t sure how your media is linked, you can refer to the Plug-in column in your bin. 

FAQ

Q: Why can I take OP1a MXF and EXR clips that were linked in v2020.4 and higher back to older 
versions of Media Composer, but not other file types? 

A: Native OP1a MXF and support for EXR files were both added with Media Composer 2019.6 with 
the initial release of UME. Therefore you can link to either file type in 2020.4 and higher and then 
take that media back to a version that supports EXR and OP1a MXF (2019.6 and higher) since the 
link will always use UME. 

Q: What does the message “This clip requires UME which is supported in Media Composer 20.4 and 
later” mean? 

A: This is the message that will appear if you attempt to link to a file that was originally linked via 
UME on a Media Composer system that does not use UME.
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New in Media Composer v2020.4
Avid S1 Control Surface

This release of Media Composer adds support for audio channel meters for both the Avid S1 Control 
Surface and the Avid Control app. See S1 documentation at https://www.avid.com/products/avid-
control

Custom Soft Keys

This Media Composer update comes with a new default set of custom soft keys for use with S1, 
Artist Control, and Avid Control tablet and phone app. The available palette of commands available 
to EUControl has been updated to include all recently added Media Composer commands from the 
command palette and menu items that are assignable to keys. This adds about 100 commands to the 
available palette, bringing it up to about 500. The exact number varies with model and options 
configured.

However, as part of this change, about 50 commands were moved into a different EUControl 
command group. This mismatch prevents them from working, so if you use any of these commands 
in your customized set of soft keys for the Artist Control or Avid Control app, you need to update 
your customization to pick up this change. You do this in the Soft Keys pane of the EUContol 
Settings. Reselecting each affected command and re-saving the customization will update the 
command to the new group.

Avid MediaFiles Folder Location

With the release of macOS v10.15.x, you cannot write media to the root of the boot drive. Therefore, 
the default location for the Avid MediaFiles folder has changed with this release. You can now find 
the Avid MediaFiles folder in the following locations:

• (Windows) drive:\Users\Public\Documents\Avid Media Composer

• (macOS) /Users/Shared/AvidMediaComposer

n If you performed an upgrade and Avid MediaFiles already exists at the root, we will continue to use 
that location. 
Also, there is no change for non-system disks. We will continue to use the root for the Avid 
MediaFiles directory.

Workspace 1 Export Clear Renders FX Bring Forward Clear Mobs

Workspace 2 Center Pan Clear Mon FX Send Back Cycle Trim End

Workspace 3 Default Pan Freeze Frame FX Group Zoom In

Workspace 4 Apply Gain Load Filler FX Ungroup Zoom Out

Workspace 5 Split All Tracks to Mono Video Output FX Lock Zoom Full Out

Workspace 6 Find Black Hole Source/Record Editing FX Unlock Play Preview

Workspace 7 Find Flash Frame Effects Editing Freeze 15 Bring Forward

Workspace 8 Add Timeline Clip Note Color Correction Freeze 30 Send Back

File New New Audio Track Audio Editing Freeze 60 Trim Slip

Import New Audio Track Stereo FX Bring to Front Two Field Both Trim Slide

Digital Cut Render FX Send to Back Two Field Inter
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New in Media Composer v2020.4
Windows 7 Note

This release of the editing application no longer supports Windows 7. The Windows versions 
supported are:

• Windows v10 64-bit v1809 or later (Professional and Enterprise)

Resolution Name Changes

A number of resolution names have been simplified.You will see the following name changes when 
selecting formats in Media Composer. 

ProRes Name Changes

DNxHD Name Changes

Old Name New Name

Apple ProRes 422 Proxy Apple ProRes 422 (Proxy)

Apple ProRes 422 LT Apple ProRes 422 (LT)

Apple ProRes 422 HQ Apple ProRes 422 (HQ)

Project - Frame Rate Old Name New Name

1080p/60 - 1920 x1080 Avid DNxHD 440x DNxHD HQX

1080p/60 - 1920 x1080 Avid DNxHD 440 DNxHD HQ

1080p/60 - 1920 x1080 Avid DNxHD 290 DNxHD SQ

1080p/60 - 1920 x1080 Avid DNxHD 90 DNxHD LB

1080p/59.94 - 1920 x1080 Avid DNxHD 440x DNxHD HQX

1080p/59.94 - 1920 x1080 Avid DNxHD 440 DNxHD HQ

1080p/59.94 - 1920 x1080 Avid DNxHD 290 DNxHD SQ

1080p/59.94 - 1920 x1080 Avid DNxHD 90 DNxHD LB

1080p/50 - 1920 x1080 Avid DNxHD 365x DNxHD HQX

1080p/50 - 1920 x1080 Avid DNxHD 365 DNxHD HQ

1080p/50 - 1920 x1080 Avid DNxHD 240 DNxHD SQ

1080p/50 - 1920 x1080 Avid DNxHD 75 DNxHD LB

1080i/59.94 - 1920 x1080 Avid DNxHD 220x DNxHD HQX

1080i/59.94 - 1920 x1080 Avid DNxHD 220 DNxHD HQ

1080i/59.94 - 1440x1080 (DNxHD-TR 145) DNxHD TR+

1080i/59.94 - 1920 x1080 Avid DNxHD 145 DNxHD SQ

1080i/59.94 - 1440x1080 Avid DNxHD 100 DNxHD TR
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New in Media Composer v2020.4
1080i/50 - 1920 x1080 Avid DNxHD 185x DNxHD HQX

1080i/50 - 1920 x1080 Avid DNxHD 185 DNxHD HQ

1080i/50 - 1440x1080 (DNxHD-TR 145) DNxHD TR+

1080i/50 - 1920 x1080 Avid DNxHD 120 DNxHD SQ

1080i/50 - 1440x1080 Avid DNxHD 85 DNxHD TR

1080p/25 - 1920 x1080 Avid DNxHD 365x DNxHD 444

1080p/25 - 1920 x1080 Avid DNxHD 185x DNxHD HQX

1080p/25 - 1920 x1080 Avid DNxHD 185 DNxHD HQ

1080p/25 - 1920 x1080 Avid DNxHD 120 DNxHD SQ

1080p/25 - 1440 x1080 Avid DNxHD 85 DNxHD TR

1080p/25 - 1920 x1080 Avid DNxHD 36 DNxHD LB

1080p/24 - 1920 x1080 Avid DNxHD 350x DNxHD 444

1080p/24 - 1920 x1080 Avid DNxHD 175x DNxHD HQX

1080p/24 - 1920 x1080 Avid DNxHD 175 DNxHD HQ

1080p/24 - 1920 x1080 Avid DNxHD 115 DNxHD SQ

1080p/24 - 1440 x1080 Avid DNxHD 80 DNxHD TR

1080p/24 - 1920 x1080 Avid DNxHD 36 DNxHD LB

1080p/23.976 - 1920 x1080 Avid DNxHD 350x DNxHD 444

1080p/23.976 - 1920 x1080 Avid DNxHD 175x DNxHD HQX

1080p/23.976 - 1920 x1080 Avid DNxHD 175 DNxHD HQ

1080p/23.976 - 1920 x1080 Avid DNxHD 115 DNxHD SQ

1080p/23.976 - 1440 x1080 Avid DNxHD 80 DNxHD TR

1080p/23.976 - 1920 x1080 Avid DNxHD 36 DNxHD LB

1080p/29.97 - 1920 x1080 Avid DNxHD 440x DNxHD 444

1080p/29.97 - 1920 x1080 Avid DNxHD 220x DNxHD HQX

1080p/29.97 - 1920 x1080 Avid DNxHD 220 DNxHD HQ

1080p/29.97 - 1920 x1080 Avid DNxHD 145 DNxHD SQ

1080p/29.97 - 1440 x1080 Avid DNxHD 100 DNxHD TR

1080p/29.97 - 1920 x1080 Avid DNxHD 45 DNxHD LB

720p/59.94 - 1280 x720 Avid DNxHD 220x DNxHD HQX

720p/59.94 - 1280 x720 Avid DNxHD 220 DNxHD HQ

720p/59.94 - 1280 x720 Avid DNxHD 145 DNxHD SQ

Project - Frame Rate Old Name New Name
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New in Media Composer v2020.4
New Select Project Window

The Select Project window has been updated. The redesign makes it easier for you to create and 
manage your projects. The window includes:

• You can easily open an existing project or create a new project.

• You can display the project list in column text view or in frame view. Rows and columns in text 
view allows you to see more information about two or more projects at once.

720p/59.94 - 960 x720 Avid DNxHD 100 DNxHD TR-SQ

720p/50 - 1280 x 720 Avid DNxHD 175x DNxHD HQX

720p/50 - 1280 x 720 Avid DNxHD 175 DNxHD HQ

720p/50 - 1280 x 720 Avid DNxHD 115 DNxHD SQ

720p/50 - 960 x720 Avid DNxHD 85 DNxHD TR

720p/29.97 - 1280 x720 Avid DNxHD 110x DNxHD HQX

720p/29.97 - 1280 x720 Avid DNxHD 110 DNxHD HQ

720p/29.97 - 1280 x720 Avid DNxHD 75 DNxHD SQ

720p/29.97 - 960 x720 Avid DNxHD 50 DNxHD TR-SQ

720p/25 - 1280 x720 Avid DNxHD 90x DNxHD HQX

720p/25 - 1280 x720 Avid DNxHD 90 DNxHD HQ

720p/25 - 1280 x720 Avid DNxHD 60 DNxHD SQ

720p/25 - 960 x720 Avid DNxHD 45 DNxHD TR

720p/23.976 - 1280 x720 Avid DNxHD 90x DNxHD HQX

720p/23.976 - 1280 x720 Avid DNxHD 90 DNxHD HQ

720p/23.976 - 1280 x720 Avid DNxHD 60 DNxHD SQ

720p/23.976 - 960 x720 Avid DNxHD 50 DNxHD TR-SQ

Project - Frame Rate Old Name New Name
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New in Media Composer v2020.4
• You can select the What’s New tab to display information about new features.

• You can set the poster frame you want displayed in the Select Project window. Once you open 
the project, right click the desired frame in the Composer monitor and select “Save as project 
poster frame”. That frame will appear in the Select Project window as the representative project 
frame.

• You can easily change the font and columns displayed from the fast menu.

Timeline Sequence Map

The Sequence Map allows you to easily see and navigate the Timeline through a simple to use 
interface that displays the entire sequence and your current view of it. You simply mouse down on the 
white box and drag in any direction on the map which re-adjusts the current view of the Timeline. 
This makes it easier to move through long and tall sequences.

Select Timeline > Show Sequence Map.

In addition, you can float, dock or tab the Sequence Map. Right click in the white area and select 
Show in Dedicated Window. The Sequence map opens in its own window. If you want to return it to 
the Timeline, right click in the dedicated window and select Show in Timeline.
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New in Media Composer v2020.4
Bulk Edit

Bulk Edit allows you to replace the data in a particular column for multiple bin items according to a 
format that can be customized. The format can contain things like strings, text from any column, and 
a counter. For example, a user can use Bulk Edit to add a prefix or suffix to all selected clips’ Names.

To perform a bulk edit:

1. Select the items in the bin where you want to perform a bulk edit.

2. Right click and select Bulk Edit.

3. Select the Column you want to Modify.

4. Choose to change which items in the bin you want to modify: the Selected items, All Bin items. 
All Master Clips, All Sub-clips, or All Sequences.

5. You can choose to replace column data with the following:

- Specified Text: Enter the text you want to change in the column.

- Counter: Enter the counter information you want to appear in the selected columsn. You can 
choose the number of digits, the starting value and the increment value.

- Column Data: You can choose to change the specified case of the text in the column.

6. Once you have made your selections, click Commit.

The changes appear in the bin for the applicable selection.
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New in Media Composer v2020.4
Blank Panel

The Add Blank Panel option allows you to define layouts and create gray space between other tools. 
The Blank Panel is resizable and can be positioned just like any other tool.

To set the Blank Panel:

1. Select File > Settings and click the User tab.

2. Double-click Interface and select the General tab. 

3. Access the “Closing a docked tool will replace it with a blank panel.”

- When selected, whenever the last paneled tool is closed in a panel, a blank panel is 
automatically added. When the tool is made visible again, the blank panel will disappear.

- When deselected, a blank panel is not automatically added when you close a paneled tool. 
You can manually add blank panels from the Windows menu and the blank panel stays in 
place until you explicitly close it. Closing a docked tool allows surrounding tools to fill the 
space.
13



New in Media Composer v2020.4
Effect Palette Update

The Effect Palette has been updated to allow you to change the font and font size of the Effect Palette 
window. Simply right click in the window, select Set font and change to the desired font and size. If 
the Effect Palette is the active window you can select Set Font on the Windows menu.

Select Muted Clips

A new feature allows you to select all muted clips in a sequence. Simply select Select->Muted Clips 
from the Timeline context menu. All muted clips are selected.

Avid Titler+ Changes
• Titler+ presets: You can override T+ attributes while preserving text

When a text layer is selected (in the viewer), you can ALT-Drag and drop an already saved T+ 
effect from a bin onto the effect icon in the effect editor. This will replace all the properties of the 
layer (colors, font, shadow etc) while preserving the text.

• Color Picker in Titler+ has been normalized like other pickers: click to pick a color, double-click 
to open the color chooser.
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New in Media Composer v2020.4
Interface Settings Update

The following have been added to the Interface Settings:

Timecode Window Brightness

You can increase or decrease the brightness in the Timecode window. Select File > Settings. Click the 
User tab and double click Interface. Click the General tab. Use the slider to increase or decrease the 
brightness. 

Timeline & Viewers Brightness Sliders

You can increase or decrease the brightness of the metadata in the viewers. Select File > Settings. 
Click the User tab and double-click Interface. Click the Timeline & Viewers tab. Use the slider to set 
the desired brightness.
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New in Media Composer v2020.4
Color on Bin Tab Only

You can set the Bin background custom color to display on tabs only. When you select Use Bin 
background color only on tabs, the custom color will appear on the tab, not in the bin behind the text.
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New in Media Composer v2020.4
Trim Settings Update

A new setting has been added to Trim Settings. The “Sync Rollers at Position In Filler” puts sync 
rollers at the blue bar in filler just like non-filler. This makes sure markers in filler will stay in sync 
with other tracks as they are trimmed. This option is defaulted on.
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New in Media Composer v2020.4
New ACES Output Transforms

Additional ACES Output Transforms are included with this release.

Mask Margin Presets

You can select 9x16 and 1:1 presets for Mask Margins and for FrameFlex framing.
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New in Media Composer v2020.4
Improved Color Correction Control

This release includes improved responsiveness and more granular control when making small Gain 
value changes in ACES color space.
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New in Media Composer v2020.4
Strip Silence

You can easily strip silence from your sequence. 

To strip silence from the sequence:

1. Load the sequence in the Timeline.

Sample before sequence

2. Select the tracks from which you want to strip silence.

3. Place an IN and OUT mark in the region you want to strip silence or Use Marks to select the 
entire region.

4. Right click in the Timeline and select Strip Silence.
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New in Media Composer v2020.4
5. Set the desired threshold. Any value below the Threshold setting will be stripped away. You can 
also adjust the region around the silence with the Pad Start and Pad End settings. And set the 
minimum duration to be detected as silence.

6. Click OK.

The silence is stripped from the sequence.
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New in Media Composer v2020.4
Sample sequence after strip silence

Mapping Buttons at the Bottom of the Timeline

You can map buttons at the bottom of the Timeline. 
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New in Media Composer v2020.4
Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be 
used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Avid Media Composer may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is 
supplied as a guide for Avid Media Composer. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of 
any kind for customers’ losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2020 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY 
NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT 
YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby 
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and 
related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to 
the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT 
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use 
acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to 
endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED ``AS 
IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided " as is"  without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided " as is"  without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, 
written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided " as 
is"  without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 
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Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice 
is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting 
documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED " AS IS" , WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER 
THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY 
OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of 
“Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any damages 
resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the 
software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost 
profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason including copyright or 
patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such 
damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to 
its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, 
Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow 
“frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to 
copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid 
Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial 
computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the 
U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant 
to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, iNEWS, ISIS, Mbox, 
MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and all related 
product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or other countries. 
The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility for Avid products. All 
other trademarks are the property of their respective owners.  For a full list of Avid trademarks, see: http://www.avid.com/US/about-avid/
legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 
countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a 
registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained 
herein are the property of their respective owners. 
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